LESSON 1: EXPLORING SAGE 50
ACCOUNTING SOFTWARE
INTRODUCTION
Today, accountants supplement their accounting knowledge with modern software
programs that automate many of the daily accounting tasks.
You’re about to learn to use one of the most popular accounting software programs, Sage
50. This program runs your general ledger and all subsidiary reports such as accounts
receivable, accounts payable, payroll, and other reports. It also prepares your financial
statements. You’ll need a copy of the Sage 50 software, Adobe Acrobat, and Microsoft
Excel (part of Microsoft Office).

SECTION 1.1
Read this section. Then read Software Installation, Preface, and Chapter 1 in
your textbook.
Objective
When you complete this section, you’ll be able to explain how to operate Sage 50’s menus.

Read the software installation instructions in the beginning of your textbook. Then, install
the software by following the procedures outlined. The text walks you through the software installation procedures. Please be patient and don’t interrupt this process.

Software Registration, Technical Support, and
Installation
Installation of the software from the DV is fairly simple and straightforward as long as you
follow the directions and use the default locations provided by Sage 50 to install the files.
Your textbook lists the minimum system requirements for use on your computer:
n

2 GHz processor

n

1 GB of RAM for single user
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The recommended system configuration is as follows:
n

2.4 GHz processor

n

1 GB RAM for single user or 2 GB for multiple users

n

2 GB hard disk space

n

Windows Vista SP2, Windows 7, Windows 8, or Windows 10 with the latest updates
from Microsoft installed. Sage 50 Accounting doesn’t have a Macintosh version.

n

1 GB of disk space for installation

n

Internet Explorer 9.0, 10.0, and 11.0 supported

n

Microsoft .NET Framework 4.5.2, which requires an additional 280 MB to 850 MB

n

At least high color (16-bit) SVGA video; supports 1024 × 768 resolution with small
fonts required

n

Printers supported by Microsoft Vista, Windows 7, Windows 8, or Windows 10.

n

In-product demos require Adobe Flash Player 11 or higher (version 18 or higher
recommended)

Please be sure that your computer system meets the minimum requirements!
Complimentary technical support by Sage 50 isn’t included with the student version.
Textbook links (such as www.mhhe.com/yacht2017) belong to the textbook publisher and
aren’t under the control of Penn Foster for functionality or content.

Sage 50 and Firewalls
Sage 50 and its database, Pervasive, can be mistakenly identified as an intrusion threat
by many firewall and antivirus programs. If not addressed properly, this may cause installation to fail or Sage 50 may not start or run properly.
To read information about Firewalls and Sage 50 Accounting, visit
https://support.na.sage.com/selfservice/viewdocument.do?noCount=true&externalId=10903&sliceId=1&cmd=&ViewedDocsListHelper=com.kanisa.apps.common.
BaseViewedDocsListHelperImpl
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Student User—Single Version Installation
The serial number for installation can be found in your textbook and on the DV. Install the
software by using the DV that accompanies the textbook. If you need assistance with the
installation, the figure for Step 5 shows the help line phone number for Sage.
After installation, activation is required. Be sure to write down and keep your Customer ID
number somewhere safe. You’ll need to have it available any time you contact Sage.
After activation, complete Step 11 to finish the installation process.
Finally, set the Global Options.
Installation can also be accomplished by downloading the software, as of this writing, at
the following website: http://www.us.sage.com/us/about-us/education. Select Sage 50
Accounting 2017—Student Version and follow the steps. The serial number for the download can be found in your text under “Download Sage 50 2017.”
Demonstration files have been set up for your benefit. For example, Sage 50 uses the fictitious company, Bellwether Garden Supply. After downloading, this data will reside on
your hard drive disk. Create a new folder named “demonstration files” to hold these files.
Follow the instructions carefully when downloading.
When you open Sage 50, you’ll see the startup window (Figure 1). In the Sage 50 startup
window, when you click Explore a sample company, you’ll see the window shown in
Figure 2. Click on Bellwether Garden Supply, and then click OK to open the Bellwether
company files. The files open in Sage 50.

FIGURE 1─This is the Sage 50 startup window.
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FIGURE 2─Click on Bellwether Garden Supply and OK to open the Bellwether
company files.
This process may take a few seconds, depending on your computer. If you installed the
Student Version included with your textbook, when doing Step 14, a window will open
reminding you that the Student Version will expire in 14 months. Your textbook gives the
expiration date of your software. Click OK to close the window. A “What’s New in Sage
50?” window will also open. If you’re familiar with Sage 50 already, you can just skim the
information by clicking the Next button. If you’re new to Sage 50, read carefully to get an
overview of the software.
If you don’t want to see the “What’s New in Sage 50?” window every time you open Sage
50, click on the box in the lower left corner to insert a check mark for the “Do not display
this screen again” option. This disables the window. To access it, click on the Help menu
at the top of the window and select “What’s New?”

Setting Global Options
Your textbook provides specific instructions on setting the Global Options. Follow the
instructions carefully to ensure that the properties are set up to match what’s presented
in the textbook. For example, the second bullet under number 1 tells you that in the Hide
General Ledger Accounts area, the boxes must be unchecked. When you bring up the
Global Settings on the Accounting tab, the Accounts Receivable and Payroll Entry check
boxes will have a checkmark in them. Uncheck them. Also, Recalculate Cash Balances
won’t have a checkmark next to it. Click on the box to insert a checkmark. Ensure each of
your settings matches the setting shown in the text before you continue.

Sage 50 accounting software package consumes a lot of computer memory. It’s
recommended you have only one software package open at a time. After exiting the
program, you may need to reboot your computer to regain the consumed memory.
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Backing Up Data
There are a few ways to back up data in Sage 50. You can use a USB flash drive, CD-R,
DVD-R, or hard drive. The textbook instructions call for backing up using a USB flash
drive. If possible, you should use a flash drive, which makes following the instructions
easier. An 8 GB flash drive is more than enough and is relatively inexpensive. Otherwise,
back up the data to your desktop and then copy and paste the file to some other media,
such as an external drive or CD. It’s important that you have your data saved to a location
other than your hard drive, in case you have a problem with your computer. Good backup
procedures are a must. You’ll find instructions on backing up in Chapter 1.

Software Hints
The Sage 50 package offers a tour of the software; you should take the time to view
these videos. The tour is located in the Help menu under Show Me How. It’s a great
learning tool, and you can view each screen at your own pace.
The Help function provides assistance in understanding the software. (Press the F1 key
on your keyboard, or click on the word Help at the top center of the window and then
click on Help from the drop-down menu that appears.) In Sage 50, Help has an index of
topics and a search function that guides you to find help on specific items (Figure 3).

FIGURE 3─Sage 50 Help has an index of topics and a search function that will
help you find help on specific items.
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Throughout this course, take time to explore the software on your own. Drop down all
the menus and become familiar and comfortable with them. Don’t change any data, but
don’t be afraid to explore. Also, back up your data on a regular basis by using the Backup
(Ctrl-D) option under the File menu at the top-left of the window.

Review of the Accounting Journals
In accounting, recall that there are five journals, or original books of entry. The flowchart
shown in Figure 4 will help you to understand which journal contains a particular entry or
transaction. Also, remember the relationships shown in Figure 5.

Does the transaction involve cash?

YES

NO

Was cash RECEIVED?

Was something PURCHASED?

YES

NO

YES

NO

Record in
the Cash
Receipts
Journal

Record in
the Cash
Disbursements
Journal

Record in the
Purchases
Journal

Was
something
SOLD?

Use the Cash Receipts &
Cash Disbursements Journals
to prepare monthly
bank reconciliations

YES

NO

Record in the
Sales
Journal

Record in the
General
Journal

FIGURE 4─Summary Flowchart of Journals Used for Cash and Accrual Basis

© PENN FOSTER, INC. 2017		
COMPUTER APPLICATIONS

IN ACCOUNTING
Lesson 1

PAGE 11

BALANCE
SHEET

INCOME
STATEMENT

{
{

Assets

DR
+

=

Liabilities

CR
–

DR
–

+

CR
+

DR
–

Revenues

+ = Increase
– = Decrease

DR
–

Owners’ Equity

CR
+

–

CR
+

Expenses
DR
+

CR
–

FIGURE 5─This illustration shows the relationships on the balance sheet and
the income statement.

Sage 50 Practice
Once you’ve read through Chapter 1 of your textbook, practice your skills by completing
Exercises 1-1 and 1-2. These exercises are for your use only. Don’t send them to your
instructor.
After you’ve carefully read Software Installation, Preface, and Chapter 1 in your textbook,
complete Self-Check 1.1. When you’re sure that you understand the material from
Section 1.1, move on to Section 1.2.
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Self-Check 1.1
At the end of each section of Computer Applications in Accounting, you’ll
be asked to check your understanding by completing a “Self-Check”
exercise. Answering these questions will help you review what you’ve
studied so far. Please complete Self-Check 1.1 now.
Fill in the blank.
1. The Navigation bar is on the _______ side of Sage 50’s windows.
2. Pressing _______ will toggle between the open window and the menu bar.
3. Using the _______ function key saves the current record in the maintenance
windows.
4. Using the function key _______ displays the online help window.
5. One advantage of Windows is that it _______ terms and operations used in
software programs.
Check your answers with those in the back of this study guide.
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SECTION 1.2
Read this section. Then read Chapter 2 in your textbook.
Objective
When you complete this section, you’ll be able to analyze payments and vendor
credit memos.
This chapter of your textbook explains how the Sage 50 software works with vendors. You
can access the screen shown in Figure 6 by clicking on the Vendors & Purchases menu
item on the left. Read this material and familiarize yourself with the navigation of Sage 50
software.

FIGURE 6─This illustration shows the location of the Vendors & Purchases option
in the Sage 50 Navigation bar.
Recall that expenses (other than noncash charges like depreciation, amortization, and
depletion) result in or become cash outflows. For example, if purchases are made on
account, they’re eventually paid off in cash. As sales are made, additional purchases of
inventory are made, as shown in Figure 7.
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Cash
disbursements
or expenses

Accounts
payable

Inventory

Cash

FIGURE 7─This illustration shows the relationships among
expenses, accounts payable, and inventory.
To prepare a statement of cash flows, you need the balance sheet for the beginning of
the period, the balance sheet for the end of the period, and the income statement for the
period. The balance sheets and income statement are prepared on an accrual basis,
using accruals (that is, accounts receivable and accounts payable). Therefore, to prepare
the statement of cash flows, you must convert these financial statements from accrual
basis back to a cash basis.
The Vendors & Purchases selection in Sage 50 logically organizes the Purchases Journal
and Cash Disbursements Journal on the same page. The Purchases Journal assists with
the recording of accounts payable–based accruals. The Cash Disbursements Journal
assists with the recording of cash outflows for the payment of accounts payable.

Sage 50 Practice
When you complete the reading assignment, practice your skills by completing Exercises
2-1 and 2-2 in your textbook.
After you’ve carefully read Chapter 2 in your textbook, complete Self-Check 1.2. When
you’re sure you understand the material from Section 1.2, move on to Section 1.3.
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Self-Check 1.2
Fill in the blank.
1. When Bellwether Garden Supply orders inventory from vendors, Account No.
12000, Inventory, is _______.
2. To begin where you left off the last time you used Sage 50, use the _______
feature.
3. The _______ feature is used to save data to the current point in Sage 50.
4. Clicking on the _______ icon on the Purchase Orders window takes you to the
Purchase Order Journal.
Check your answers with those in the back of this study guide.

SECTION 1.3
Read this section. Then read Chapter 3 in your textbook.

Objective
When you complete this section, you’ll be able to describe how to enter customer
terms and record a sales invoice.

Chapter 3 of your textbook introduces how Sage 50 works with customer transactions.
You’ll learn about quotes and sales orders, and how to enter the customer maintenance information when posting entries. Follow the directions in your textbook carefully to familiarize
yourself with the navigation of Sage 50 software. Figure 8 shows the Customers & Sales
option in the Sage 50 Navigation bar. You can access the screen shown in Figure 8 by
clicking on the Customers & Sales menu item at left on the Navigation bar.
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FIGURE 8─The Customers & Sales option is shown here.
Generally, sales or revenues result in or become cash inflows. Sales that are made on
credit or account become accounts receivable and are eventually collected as cash and
used to finance additional inventory purchases. This relationship is shown in Figure 9.

Sales or
revenues

Accounts
receivable

Inventory

Cash
FIGURE 9─This illustration shows the relationship between
sales or revenues and accounts receivable.
In Sage 50, be sure to familiarize yourself with the contents of the Customers & Sales
Tasks. Look back at Figure 8 for a moment. The Customers & Sales button allows you
to view and edit customer accounts. On the right side of the figure, note the available
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headings—each customer file has a customer identification name, telephone number,
and accounts receivable balance due. New customers will be added to this list. The Jobs
button allows you to view and edit individual jobs. New jobs would be added to this list
and completed jobs would be removed from this list. The Quotes and Proposals button
allows you to view and edit quotes. Under Recently Used Customer Reports, explore
the reports available, including Aged Receivables, Customer Transaction History, Sales
Journal, Invoice Register, and Cash Receipts Journal.
The organization and contents of these reports should seem reasonable and appear
logical. The Sales Journal and the Cash Receipts Journal are related, as are Accounts
Receivable and the Aged Receivables report.
Recall the typical journal entries that are likely to result from cash sales and credit sales,
as well as collections on accounts receivables. The Sage 50 software system allows you
to make these journal entries, just as you’ve learned earlier in your accounting studies,
without having to record the transactions manually in separate, physical journals or
original books of entry. Instead, SCA effectively builds the journals (or original books of
entry) for you, and you enter the transactions in general journal entry form.
Figure 10 shows the Customer Management tab that may also be selected under
Customers & Sales. The options under Customer Management are more limited, but
Sales Invoices is probably the most important information that you’ll access from this tab.

FIGURE 10─This illustration shows the Customer Management tab under
Customers & Sales.
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Sage 50 Practice
When you complete the reading assignment in your textbook, practice your skills by completing Exercise 3-1 and Exercise 3-2.
After you’ve carefully read Chapter 3 in your textbook, complete Self-Check 1.3. When
you’re sure you understand the material from Section 1.3, move on to Section 1.4.

Self-Check 1.3
Fill in the blank.
1. You can use the _______ to see an overview of all outstanding invoices.
2. The _______ task allows you to enter a quote for a customer.
3. The _______ task is used to enter invoices to customers.
4. The _______ lists the sales tax for the transaction, the price for each item, and
the amount to be received from the customer.
5. The _______ window is used when you’re ready to ship items to customers.
Check your answers with those in the back of this study guide.
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SECTION 1.4
Read this section. Then read Chapter 4 in your textbook.
Objective
When you complete this section, you’ll be able to explain how to enter and store
information using the Maintain Employees/Sales Reps window.

Chapter 4 of your textbook shows you how Sage 50 handles employees and payroll.
Follow the directions in your textbook carefully to familiarize yourself with the Sage 50
software navigation. Figure 11 shows the Employees & Payroll option in the Sage
50 Navigation bar. You can access the screen shown in Figure 11 by clicking on the
Employees & Payroll menu item on the left.

FIGURE 11─The Employees & Payroll option is shown here.
In Sage 50, be sure to familiarize yourself with the contents of the Employees & Payroll
Tasks. Look at Figure 11 for a moment. The Employees button allows you to view and
edit employee files. On the right side of the figure, note the available headings—each
employee file has an employee identification number, telephone number, and pay
method. New employees will be added to this list. Note that there’s also a list labeled
1099 Vendors. These are vendors who must be sent a 1099 form at federal tax time.
Under Recently Used Employee Reports, explore the reports available, including
Payroll Register, Payroll Check Register, Tax Liability Report, Current Earnings Report,
and Payroll Journal.
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SAGE 50 PRACTICE
When you complete the reading assignment in your textbook, you can practice your skills
by completing Exercise 4-1 and Exercise 4-2.
After carefully reading Chapter 4 in your textbook, complete Self-Check 1.4. When you’re
sure you understand the material from Section 1.4, move on to Section 1.5.

Self-Check 1.4
Fill in the blank.
1. When working with Bellwether Garden Supply in Chapter 4, the first step in setting
up payroll is to go to the Employees & Payroll Navigation Center and then select
Employees > _______.
2. The accounts affected by paychecks are _______ specifically set up to handle
payroll.
3. In Sage 50, voluntary payroll deductions are called _______ and can include gas,
union dues, and savings bonds.
4. On the _______ window, you define payroll fields and tax information for individual employees.
5. The employee wages expense account is _______ for the gross amount of the
paycheck and any deductions used are credited.
Check your answers with those in the back of this study guide.
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SECTION 1.5
Read this section. Then read Chapter 5 in your textbook.
Objective
When you complete this section, you’ll be able to explain how to record and post
a General Journal entry to transfer funds and display the General Ledger Trial
Balance.
Chapter 5 of your textbook will teach you how to manage the General Ledger Chart of
Accounts. You’ll also learn how to use Sage 50’s Inventory system. Sage 50 uses a perpetual
inventory system. This system involves keeping track of each purchase and sale as it
occurs. There’s a lot of information included, so you can be very precise in your work.
Follow the directions in your textbook carefully to familiarize yourself with the Sage
50 software navigation. Figure 12 shows the Inventory & Services option in the Sage
50 Navigation bar. You can access the screen shown in Figure 12 by clicking on the
Inventory & Services menu item on the left.

FIGURE 12─The Inventory & Services option is shown here.
At this time, take a few minutes to explore and familiarize yourself with the contents of
the Inventory & Services Navigation Center. Look back at Figure 12 for a moment. The
Inventory Items button allows you to view and edit inventory files. On the right side of
the figure, note the available headings. Each item file includes the inventory identification
number, a brief description of the item, the number of units sold, and the remaining
quantity on hand. Any new inventory will be added to this list, and because Sage 50 uses
a perpetual inventory system, you can be confident that this information is up to date.
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Now, explore the reports available under Recently Used Inventory Reports. You’ll find the
Inventory Profitability Report, the Item Costing Report, the Inventory Adjustment Journal,
the Inventory Stock Status Report, and the Physical Inventory list.
Refer to Figure 13, which shows the Banking option in the Sage 50 Navigation bar.
You can access the screen shown in Figure 13 by clicking on the Banking menu
item on the left. Take a few minutes to familiarize yourself with the contents of the
Banking Tasks. Note the headings on the right side of the screen. You’ll find Bills to
Pay, Account Balances, and Online Banking. Under Recently Used Banking Reports,
explore the reports available, including Account Register, Bank Deposit Report, Account
Reconciliation, Deposits in Transit, and Outstanding Checks.

FIGURE 13─The Banking option is shown here.
Now, take a look at the Chart of Accounts button, which is found under Banking Tasks
in the middle of the window.
When you click on the Chart of Accounts button, a menu will pop up. Select View and
Edit Accounts. A new window titled Account List will open up, showing the Chart of
Accounts. You can see the Chart of Accounts displayed in Figure 14. For each account,
you’ll be able to view the account’s identification number, a brief description, the type of
account, and the account’s running balance.
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FIGURE 14─The firm’s Chart of Accounts is shown here.

Sage 50 Practice
When you complete the reading assignment in your textbook, practice your new Sage 50
skills by completing Exercise 5-1 and Exercise 5-2. After carefully reading Chapter 4 in
your textbook, complete Self-Check 1.5. When you’re confident that you understand the
material from Section 1.5, move on to Section 1.6.
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Self-Check 1.5
Fill in the blank.
1. In a/an _______, an up-to-date record of inventory is maintained, recording each
purchase and each sale that occurs.
2. When you sell inventory items on account, there’s a compound journal entry in the
_______, which includes debits to accounts receivable and cost of sales accounts
and credits to sales, sales tax payable, and inventory accounts.
3. The Money Market Fund account is classified as a/an _______.
4. Bellwether Garden Supply tracks oriole feeders as a/an _______.
5. On the _______ window, you can set defaults for the item class.
Check your answers with those in the back of this study guide.
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SECTION 1.6
Read this section. Then read Chapter 6 in your textbook.
Objective
When you complete this section, you’ll be able to describe how to coordinate job
costs with purchases, sales, and payroll.
This chapter shows you how to use the Job Cost system in Sage 50 Accounting. This feature allows you to track the costs a business incurs while it’s performing a job. Follow the
directions in your textbook carefully to familiarize yourself with the Sage 50 software navigation and features.

Sage 50 Practice
When you complete your reading assignment in the Sage 50 textbook, you can practice
your Sage 50 skills by completing Exercise 6-1 and Exercise 6-2.
After you’ve carefully read Chapter 6 in your textbook, complete Self-Check 1.6. When
you’re sure you understand the material from Section 1.6, move on to Section 1.7.
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Self-Check 1.6
Fill in the blank.
1. Sage 50 lets you assign _______ to purchases, sales, and employee hours.
2. Sage 50’s _______ feature allows you to track the costs incurred while performing
a job.
3. Account No. 57200, Materials Cost, is the default account displayed on the
_______ window.
4. The _______ window displays Account No. 40000-EQ, Sales-Equipment, as the
default account for Franklin Botanical Gardens (FRANKLIN).
5. The _______ breaks down each job according to what was spent or earned for
each affected general ledger account.
Check your answers with those in the back of this study guide.

SECTION 1.7
Read this introduction. Then read Chapter 7 in your textbook.
Objective
When you complete this section, you’ll be able to identify financial statements and
their features.
In the first part of your textbook, you explored the sample company, Bellwether Garden
Supply. In this chapter, you’ll learn how the Sage 50 system compiles financial
statements. Once the various journal entries have been recorded and posted, Sage 50
automatically calculates the company’s financial statements. Follow the directions in your
textbook carefully to familiarize yourself with these financial statements and how Sage 50
produces them.
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Sage 50 Practice
When you’ve completed the reading assignment in your textbook, you can practice your
skills by completing Exercise 7-1 and Exercise 7-2.
After you’ve carefully read Chapter 7 in your textbook, complete Self-Check 1.7. When
you’re confident that you understand the material from Section 1.7, move on to Section 1.8.

Self-Check 1.7
Fill in the blank.
1. All financial statements show the current month and _______ amounts, and each
may be modified to fit the user’s needs.
2. The _______ financial statement is a custom report designed for the sample
company, Bellwether Garden Supply.
3. _______ allows you to organize your business by department.
4. In Sage 50, when a wrench is shown next to a financial statement it means that
the statement is a/an _______.
5. Net _______ results when the expenses are greater than revenues.
Check your answers with those in the back of this study guide.
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SECTION 1.8
Read this introduction. Then read Chapter 8 in your textbook.
Objective
When you complete this section, you’ll be able to explain how to use the time and
billing feature to complete a time ticket, sales invoice, and payroll entry.

This assignment introduces you to another fictional company, Stone Arbor Landscaping.
You’re going to learn how to use Sage 50’s Time & Billing feature to track expenses and
time when working with customers. Follow the directions in your textbook to familiarize
yourself with this feature.
When you open Sage 50, you’ll see the startup window. In the startup window, click
Explore a Sample Company and you’ll see the window that’s shown in Figure 15. Click
the radio button next to Stone Arbor Landscaping, and then click OK to open the Stone
Arbor company files.

FIGURE 15─Click on Stone Arbor Landscaping and OK to open the
Stone Arbor company files.
When you select Stone Arbor Landscaping and click OK for the first time, the company’s
files will begin extracting automatically, and a new message window will appear to let you
know how much time active time you have left before your software expires. Click OK,
and you’ll be able to open the Stone Arbor Landscaping company files.
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Sage 50 Practice
When you complete the reading assignment in your textbook, practice your new skills by
completing Exercise 8-1 and Exercise 8-2.
After you’ve carefully read Chapter 8, complete Self-Check 1.8. When you’re sure that
you understand the material from the eight assignments in Lesson 1, follow the instructions to take the examination for Lesson 1. When you’ve completed the exam, move on
to Lesson 2, Section 2.1.

Self-Check 1.8
Fill in the blank.
1. _______ gives you a way to track expenses and time when working with your
customers.
2. _______ tickets are used to record time-based activities such as research or
consultations.
3. _______ tickets are used to track and aid in the recovery of customer-related
expenses.
4. Both time and expense tickets can be used in the _______ window to bill your
customers.
5. To look at the inventory maintenance information for Stone Arbor Landscaping, the
Maintain > _______ window is used.
Check your answers with those in the back of this study guide.
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